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QuikCalc Home Edition V6.0 

For when all you need is a quick, accurate schedule. 

QuikCalc Amortization comes in four editions to meet your needs and is in use by thousands of professionals, 

individuals and government departments around the world. The Home Edition's simple to use interface allows 

you to quickly generate accurate schedules. Order now and be up and running immediately.  

� Quickly and easily create accurate amortization schedules 

� Create schedules for different payment frequencies including bi-weekly and weekly  

� Solve for payment amount, loan amount, interest rate or loan period then instantly create a schedule 

� Reports can be summarized annually and printed by date range  

� Create payment grids within seconds 

 

 

> Try the demo now! 

QuikCalc Home Edition is a fast, easy to learn, user-friendly tool that allows you to 
create amortization schedules, payment grids and more. 

Need Amortization Schedules Fast? Quickly and easily create accurate amortization schedules that show you 

the principal and interest breakdown along with running totals of interest paid plus remaining balance. 

View Screen Shot 

Missing a variable? If you need a quick answer for a missing variable, the Solve for Missing Number calculator 

will meet your needs. Solve for the payment amount, loan amount, interest rate or loan period at the click of a 

button, then with another click create a schedule based upon the data. 

Need Payment Grids? Quickly create not just loan payment tables but five different grid configurations allow 

you to quickly see at a glance the impact of loan amounts, interest rates and payment amounts. 

Detailed and summary reports are at your fingertips. Generate reports on demand that include annual 

summaries based upon any corporate year end. You choose the level of detail and the years between which the 

report will be generated. You can also specify custom header and footer text. 

< Back to Benefits 

 

 

> Try the demo now! 

QuikCalc Home Edition includes all of the features you need to generate basic, 
accurate amortization schedules. Save money by getting only what you need with 
QuikCalc Home Edition. If you need more complex schedules or loan tracking, check 
out the Plus! Edition by clicking here. 

Amortization Schedules 

Quickly and easily create accurate amortization schedules that show you the principal and interest breakdown 

along with running totals of interest paid plus remaining balance. More >> 

Solve for Missing Number Calculator  

The Solve for Missing Number calculator allows you to enter your known values and solve for the missing 

payment amount, loan amount, interest rate or amortization period. More >>  

Payment Grids 

Quickly create not just loan payment tables but five different grid configurations allow you to quickly see at a 

glance the impact of loan amounts, interest rates and payment amounts. More >> 

Click Here to Collapse All 

QuikCalc Home Edition Benefits Click Here to Collapse 

Home Edition Features Click Here to Collapse 
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Need More Features? Try... 
QuikCalc Plus! Edition $69.95 

QuikCalc Premium Edition $139.95 

QuikCalc Office Edition $299.95 

Available Add-ons: 
Corporate Logo Plug-in $59.95 

Other Products: 
FirstResponse Email Reply Management System 

FirstResponse $99.95 

 

Income Needs Analyzer and Net Worth Calculator 

Retire! Four Editions starting at $39.95 

 

Debt Elimination & Consolidation Software 

DebtCalc Three Editions starting at $39.95 

Vehicle Loan vs. Lease Software 

VehiCalc Two Editions Starting at $39.95 

 
QuikCalc is quick and easy to learn and is already 

in use by thousands of individuals and 

professionals across the United States and the 

world. We've been in business for over 10 years 

and offer a 60 day money back guarantee on all 

of our software so there is no risk to you! 

  

 

Home Edition 

$39.95 
Available for Immediate 

Download and on CD-

ROM 

  



Detailed Reports  

Detailed reports are available that will allow you to see on paper varying levels of detail on the loans, schedules 

or grids stored in the system. More >>  

Just a few more of the key features: 
 

< Back to Features 

Fast, Accurate Amortization Schedules 
 

Quickly and easily create accurate amortization schedules with QuikCalc Amortization. 

< Back to Features 

Solve for Missing Number Calculator 
 

The Solve for Missing Number calculator allows you to enter your known values and solve for the payment 

amount, loan amount, interest rate or amortization period. Simply enter what you know and click on the 

calculator icon beside the parameter you don't know and QuikCalc will immediately solve for the missing number. 

Once finished, you can create a schedule or loan using the calculated parameters with the click of a button. 

View Screen Shot  

< Back to Features 

Dynamic Payment Grids
 

The Payment Grids tool allows you to generate grids in five different configurations showing payment and loan 

amounts based upon various variables along the X and Y axis of the chart. For example, a payment grid with the 

loan amount on the left and the interest rate across the top. This tool replaces the old mortgage table books that 

are not flexible enough for today's wide array of loan types. 

• 
Compatible with US & Canadian mortgages, U.S. Rule (Simple Interest) loans, car loans, business 

loans, debt-consolidation loans, student loans and more

•   
Easy to use Amortization Schedules include principal and interest breakdowns with running totals of 

interest paid and principal remaining

•   

Solve for missing number calculator allows you to enter your known values and solve for the 

payment amount, loan amount, interest rate or amortization period and then create a schedule 

based upon that information

•   
Dynamic Payment Grids including five different grid configurations allowing you to solve for most 

missing variables

•   
Detailed Reports including annual summaries. Allows you to specify a date range when printing

•   
Save your grids and schedules for future use

•   
Create schedules directly from the Solve for Missing Number calculator

• Create and save any number of amortization schedules

• 
Allows you to set the loan amount, interest rate, payment frequency (including accelerated 

payments) and interest compounding frequency

• Includes principal/interest breakdowns along with running totals of interest paid and principal owing

• Any payment frequency including monthly, bi-weekly and weekly

• Allows you to print your schedule in 5 different formats and specify a date range for the years to print

• Different compounding methods include U.S. Rule (Simple Interest) and Canadian mortgages

• Specify a start date for the schedule or use generic time references 

• Before and After display shows the effect of the latest changes

• Undo and Redo buttons allow you to go back and forth through your calculation changes

• Five different report formats can be printed for different date ranges using specific from and to dates

• 
Annual reports can be summarized based upon any fiscal year end showing interest and principal paid 

during the year

• View Screen Shot 



< Back to Features 

Detailed Reports 
 

Detailed reports are available that will allow you to see on paper varying levels of detail on the schedules or grids 

stored in the system. With most, you can specify a year range to print allowing you to see schedules for a specific 

period. You can also save these reports in HTML format which can then be emailed or included in other products 

such as Microsoft Word and Excel. You can also specify custom header and footer text! Here are just some of the 

reports: 

< Back to Features 

 

 

> Try the demo now! 

This latest version is the most significant facelift that QuikCalc has ever received and 
is receiving rave reviews from our customers. 

� New, improved interface! Once click access to most features from the new XP style Navigation Bar. 

Redesigned for 1024 x 768 to maximize the usable space on your desktop (800 x 600 mode available 

from Edit menu). Larger easier to read font used throughout.  

� Easier to Use! The new Navigation Bar makes accessing your favorite features much easier. As well, all 

date fields now have integrated calendars to make date selection much simpler.  

� User requested enhancements! Enhancements requested by people like you including redesigned 

reports that use larger fonts where possible, escrow columns now only displayed on reports when 

necessary  

� Plus dozens of other enhancements requested by our users!  

 

 

> Try the demo now! 

 

• Change any parameter and instantly see the results.

• Five different grid configurations allow you to solve for most missing parameters.

• Print them out for when you go to the bank or meet with your real estate agent.

• 
Open any number of these windows and compare side-by-side different payment frequencies, interest 

rates, compounding, periods and loan amounts.

• View screen shot

• Amortization Schedule - Payments Only Report

• Amortization Schedule - Payment Breakdown Report

• Amortization Schedule - Annual Summary

• Amortization Schedule - Annual Payment Summary

• Amortization Schedule - Annual Payment Breakdown

• Payment Grid

• Plus more!

What's New in V6.0 Click Here to Collapse 

Customer Reviews Click Here to Collapse 

I just wanted to take a minute and thank you for the hands on support that 

your organization provided to Maaco. The application modifications that we 

requested were performed with a true willingness to give the customer 

exactly what they wanted. I believe that those enhancements will provide 

value to your other customers as well. The program application is currently 

being used to provide floor planning to three automotive dealerships. I would 

be very comfortable being a reference to Slateboard if ever the opportunity 

arose. 

Thanks again, 



 

 

"I wanted to let you folks know that the software is great since the changes you made to address my specific 

problems last year. I find that I use it for many different things, and it helps me greatly with my budgeting and 

investing decisions. I even found an error my bank made and had it corrected. Sincerely," 

Spring R., Indiana 

 

"I looked all over the net and couldn't find anything that did what I needed until I found yours." 

 

Nancy W., Bookkeeper, Indiana 

 

"Used your software today and it is really easy to use and very helpful. Thanks!" 

 

Leatha T., Arizona 

 

"I appreciate the quick response." 

 

Hugh H., British Columbia 

 

"You guys rock!" 

 

Shannon S., Minnesota 

 

"Very helpful" 

 

John E., New Zealand 

 

"Thanks! You guys are awesome. I'm impressed with the support!" 

 

Ed T., Texas 

 

"Love the software." 

 

John E., New Zealand 

< Back to Customer Reviews 

 

 

Neil S. Cooper 
Chief Financial Officer 

Maaco Enterprises, Inc. 

We use your software for our Housing Rehabilitation Program. The program 

involves Grants and low-interest Loans. Your QuikCalc Program is the 

software that we have chosen to track the financial portion of the program. It 

has all the tools we need, and is easy to use. 

Slateboard excels at their commitment to their clients. I can’t thank you 

enough for the excellent Customer Technical Support that your company 

provides. Your support staff has answered every question, walking through 

the application step-by-step. Many companies say they provide Customer 

Support but fall short of their promise. Slateboard sets the standard for 

Customer Service!  

 

I highly recommend Slateboard Software. 

Thanks …  

Kathleen Newcomer 

Borough of Chambersburg 

Housing Rehabilitation 

System Requirements & FAQs Click Here to Collapse 



> Try the demo now! 

System Requirements 

FAQs 

Please click below to find answers to these common questions about purchasing. 

If you have additional questions, please contact Customer Service via email at sales@slateboard.com. 

How soon will I receive my software?  

How long will it take to download?  

Can I download again if I need to reinstall my software?  

I have additional questions about downloading...  

How do I update my data from a prior version of QuikCalc?  

How do I get help or technical support?  

Where can I find information about or purchase the Canadian version of QuikCalc?  

Do you have a money back guarantee? 

How soon will I receive my software? 

If you order a CD-ROM, you can expect to receive it within 5-7 business days. If you purchase via download, the 

product is immediately available to you when the download process is completed. Note that you can also 

download when ordering a CD-ROM. 

< Back to FAQs 

How long will it take to download? 

Download times will differ depending on Internet connection speed and other factors. Typically downloads via 

"high-speed" connections take 1-3 minutes. Downloads via dial-up are usually much slower and can take 20-40 

minutes depending upon the connection speed. 

< Back to FAQs 

Can I download again if I need to reinstall my software? 

Yes. Just visit our Downloads section, select Download My Order and after installing use your registration number 

for full access. I you have lost this number, please email sales@slateboard.com with as much information as 

possible for us to identify your order and we will send you your code. 

< Back to FAQs 

I have additional questions about downloading... 

For a detailed explanation on how to download, please visit our How to Download Software Over the Internet 

page. 

< Back to FAQs 

How do I update my data from a prior version? 

If you install on the same machine as your old version, simply run and register your new software. Once 

successfully set up, go to the File Menu and select the Upgrade My X Database menu item where X is the version 

number. Only versions you have installed will be displayed. Once selected, your data will be transferred to the 

new version. 

< Back to FAQs 

How do I get help or technical support? 

Most questions can be answered by reading the online help or QuikStart guides available from the Help menu in 

your software. If your answer cannot be found there, email support is free for as long as you use your software. 

Send your question to support@slateboard.com. 

< Back to FAQs 

Where can I find information or purchase the Canadian version? 

All of our software is compatible with Canadian style mortgages and loans. When creating a Canadian mortgage, 

simply select a Compounding method of Canadian. Note that all prices on this site are in US$ unless otherwise 

noted.  

< Back to FAQs 

Do you have a money back guarantee? 

QuikCalc is quick and easy to learn and is already in use by thousands of individuals and professionals across the 

United States and the world. We've been in business for over 10 years and offer a 60 day money back guarantee 

on all of our software so there is no risk to you! For more details on our money back guarantee, click here. 

Computer IBM or Compatible Pentium class PC (Pentium II or higher recommended)

Operating System Windows Vista, XP, Windows 2000, or Windows Server 2003

Memory 64 MB of RAM (128 MB RAM recommended)

Hard Disk Space 45 MB free disk space required

Monitor 1024 x 768 resolution or higher recommended (800 x 600 mode available from Edit menu) 

Printer (optional) Required to print reports but not to operate program. Any printer supported by Windows



< Back to FAQs 

 

 

> Try the demo now! 

The feature grid below will help you decide which edition of QuikCalc is right for you. If you still aren't certain, remember that you 
can upgrade to any higher edition for the price difference at any time. As well, we have a 60 day money back guarantee on all of 
our products. 

Compare Editions Click Here to Collapse 

 
QuikCalc 

Home Edition 

QuikCalc 

Plus! Edition

QuikCalc 

Premium 

Edition

QuikCalc 

Office Edition

Price $39.95 $69.95 $139.95 $299.95

Fully functional demo available.
 

Purchase securely on our web 

site.  

 

Users can share data over a 

network
   

Multiple simultaneous users    

Track your data by client    

Generate Payment Receipts for 

your clients
   

Number of Reports available 6 24 24 48

Print Payment Coupons for your 

borrowers.
 

Includes the Loan Manager  
 

Up To 5 Loans 
 

Unlimited 
 

Unlimited 

Track multiple interest rates   

Track multiple loan terms   

Track Interest/Insurance/Tax 

escrow accounts.
  

Assess late fees or penalties.   

Associate names and addresses 

with loans
  

Track actual payments made   

Specify different interest and 

payment start dates
  

Calculate early payout amounts 

and optionally update the 

schedule to reflect that change

 

Add, skip and override 

payments
 

Dozens of financial calculators  

Add any number of extra 

payments
 

Put an annual lump-sum 

payment on your loan starting 

in any year. 

 

See effect of skipping any 

number of payments
 

Change any payment amount 

including your regular payments
 

Handles negative amortization  

Multiple Day Count Conventions 

including 30/360 and 

Actual/Actual

 

Multiple Payment Types 

including interest only and fixed 

principal plus interest.

 

Allows schedule comparisons.  

Solve for missing number 

calculator

Payment Grids 

Amortization Schedules



Still Have a Question? 

If you still have a question, please contact us and we will be happy to help you decide what edition is right for 

you. Simply email us at sales@slateboard.com and we will respond shortly. 

< Back to Compare Editions 

 

 

> Try the demo now! 

 

< Back to Compare Competition 

 

> Try the demo now! 

Allows U.S. Rule (Simple 

Interest) loans.

Handles accelerated payments

Handles US and Canadian 

mortgages

Printable reports including 

annual summaries

Save grids and schedules for 

future use

Export reports in HTML

Data file backup and restore

Further Details Click Here Click Here Click Here Click Here

Compare the Competition Click Here to Collapse 

Ten Reasons Why QuikCalc Home Beats the Competition! 

1 

Convenience 

Unlike free web-based calculators, it is always on your desktop, ready to go. No searching, no 

downed servers, no clogged internet connections. 

2 
Privacy 

No worries about someone tracking you or your activity while doing your personal financial 

calculations.

3 
Speed 

No waiting for the server or your internet connection. QuikCalc is as fast as your computer.

4 
No Back Buttons 

Every time you want to do a new calculation, you don't have to use your back button which 

sometimes doesn't reload properly.

5 
No Multiple Sessions 

On a web calculator you must open a new page for each calculation, in QuikCalc you can 

have any number open in one program.

6 
Amortization Schedules 

Most free calculators only allow you to enter a few numbers then hit a button to get an 

answer, they aren't schedules. 

7 
Flexibility 

Most online calculators don't allow you to change the interest compounding or do accelerated 

payments. Especially important for Canadians.

8 
User Friendly 

Unlike clumsy web interfaces, get all of the advantages of the Windows operating system 

interface.

9 
Upgrades 

For 30 days try out QuikCalc Plus! for free. If you like it, upgrade for the difference.

10 
No Risk! 

We have a 60 day money back guarantee! If you are not completely satisfied, you get your 

money back. No hassles, no forms, no restocking fees, no risk!

Some Facts About Us Click Here to Collapse 



 

 

  

 

 

Need help making the buying decision? We offer fully functional demos of all of our products. Simply use the links 

below to try out QuikCalc before buying. Once installed, use the Demo Now button for full access. If you are not 

familiar with downloading software from the Internet, click here for detailed step-by-step instructions. 

  

• 
Stable 

We've been in business since 1994 and have thousands of satisfied clients around the world  

• 
Safe 

We offer a 60-day unconditional money-back guarantee so there is no risk to you

• 
Satisfaction 

The Home Edition has an over 99% satisfaction rate based upon number of refunds 

requested

• 
Support 

We offer unlimited free email support

Try the Fully Functional Demo Now! Click Here to Collapse 

Click Here to try QuikCalc Premium, Plus! or Home Editions (7.2MB)

Click Here to try QuikCalc Office Edition (7.2MB)
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